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User Guide 
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Overview 

Microsoft Entourage is an e-mail client software used to manage personal information like notes, address 

book, personalized calendar, tasks etc. of the mail user client. It is used for reading, sending and saving 

e-mail messages. Mails and other information are stored in a file named as database by default. MS 

Entourage can also be connected with Microsoft Exchange server. Sometimes the data stored in 

Microsoft Entourage becomes inaccessible due to corrupt database file.  

 

Stellar Phoenix Entourage Repair is a powerful software to repair corrupted Entourage database files. It 

supports MS Entourage 2004 and upgraded version of 2008. Software rebuilds the database file without 

doing any change to the corrupted file. It recreates a repaired file at a location of user's choice. All e-

mails, address book, calendar, notes, reminders and tasks are recovered in the repaired file.   

 

Key Features of Stellar Phoenix Entourage Repair 

 

 Preview E-mail before actual recovery. 

 

 Preview Address Book, Calendar, Notes and Tasks. 

 

 Recovers E-mails, Address Book, Calendar, Notes and Tasks. 

  



Installation Procedure 

Before installing the software, ensure that your system meets minimum system requirements. 

 

Minimum System Requirements 

 Processor: Mac-Intel, Mac Power PC (G4 or above) 

 Operating System: Mac OS X 10.6 or above 

 Memory: 1 GB RAM 

 Hard Disk: 40 MB of free space 

 

Steps to install Stellar Phoenix Entourage Repair 

 

To install Stellar Phoenix Entourage Repair, follow these steps. 

 

 Unpack StellarPhoenixEntourageRepair.dmg.zip file. 

 After decompressing it, double click .dmg file. This will mount a virtual volume - 

StellarPhoenixEntourageRepair. 

 Double-click StellarPhoenixEntourageRepair volume to open Stellar Phoenix Entourage Repair 

window.  

 Drag Stellar Phoenix Entourage Repair file to Applications folder. 

 To launch the software, double click on Stellar Phoenix Entourage Repair file in Applications 

folder. 

 This displays License Agreement. If user accepts the License Agreement, then the software is 

launched; otherwise, it quits. 

 

Note: To remove the software, drag and drop the Stellar Phoenix Entourage Repair file from 

Applications folder to trash. 

  



Order and Register 

Order Stellar Phoenix Entourage Repair 

 

The software can be purchased online. For price details and to place an order, please visit 

http://www.stellarinfo.com/email-repair/entourage-recovery/buy-now.php . 

Once the order is confirmed, a pre-paid registration key will be sent through e-mail, which would be 

required to register the software. 

 

Register Stellar Phoenix Entourage Repair 

 

1. On the Tools menu, click Register. Registration window is displayed.  

2. Do one of the following: 

 If you have purchased the product and received registration key, 

 Select 'I have a key to register the product' option. Click OK. 

 In the Registration Key box, type the key. Click OK. 

 If you have to purchase the product, 

 Select 'I don't have a key to register the product'. Click OK to purchase the 

product. 

 

Alternatively, whenever you repair any database file using the demo version and try to save it, 'Stellar 

Phoenix Entourage Repair Registration' window will appear. Follow Step 2 mentioned above to register 

and to save all the recovered files. 

 

Note: User can only view the repaired file in demo version. To save the repaired file, product has to be 

registered. 

  

http://www.stellarinfo.com/email-repair/entourage-recovery/buy-now.php


Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar Products. 

You can either Call Us or Go Online to our support section at http://www.stellarinfo.com/support/.  

For price details and to place the order,click http://www.stellarinfo.com/email-repair/entourage-

recovery/buy-now.php  

Chat Live with an Online technician at http://www.stellarinfo.com/.  

Search in our extensive Knowledge Base at http://www.stellarinfo.com/support/kb/ 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php 

E-mail to Stellar Support at support@stellarinfo.com 

 

  

Support Helpline 

 

Monday to Friday [ 24 Hrs. a day ] 

 

USA (Toll free Pre Sales Queries) +1-877-778-6087 

USA (Post Sales Queries) +1-732-584-2700 

UK (Europe) +44-203-026-5337 

Australia & Asia Pacific +61-280-149-899 

Netherlands Pre & Post Sales Support +31-208-111-188 

Worldwide +91-124-432-6777 

  Email Orders   orders@stellarinfo.com 
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User Interface 

The main user interface of Stellar Phoenix Entourage Repair is as shown below: 

 

The user interface contains menus and buttons which allows you to access various features of the 

software. 

  



Menus 

StellarPhoenixEntourageRepair Menu 

About StellarPhoenixEntourageRepair 

Click on this option to know about the 

software in detail.  

Services 

Click on this option to browse the services 

offered by the software.  

Hide StellarPhoenixEntourageRepair 

Use this option to hide the icon of this 

software on your screen. 

Hide Others 

Use this option to hide other software icons 

on your screen.  

Quit StellarPhoenixEntourageRepair 

Click on this option to exit from the software.  

 

 

File Menu 

Open File 

Click on this option and select the desired file 

from which you want to repair the data.  

Save Repaired File 

Use this option to save the repaired file in the 

desired location. 

 



 

Tools Menu 

Register 

Use this option to register the purchased 

software and avail its full benefits after entering 

the registration key.  

 

 

Help Menu 

Help Topics 

Use this option to view the detailed 

help manual of the software.  

Order Stellar Phoenix Entourage 

Repair 

Use this option to buy Stellar Phoenix 

Entourage Repair software.  

Email to Stellar Support 

Use this option to e-mail back and forth 

with the Stellar Support team.  

View Support Section 

Use this option to view the support 

page of stellarinfo.com.  

Submit Enquiry 

Use this option to submit enquiry to 

stellarinfo.com. 

 

http://www.stellarinfo.com/email-repair/entourage-recovery/buy-now.php
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/enquiry.php
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View Knowledge Base Articles  

Use this option to visit Knowledge Base 

articles of stellarinfo.com. 
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Buttons 

 

 

Click on this button to view your mails that have been repaired by the software.  

 

 

Click on this button to view the repaired address book.   

 

 

Click on this button to view the repaired calender entries.  

 

 

Click on this button to view the details of repaired notes. 

 

 

Click on this button to view the repaired tasks.  

 

 

Click on this button to select the file that you want to repair.  

 

Click on this button to save the repaired data.  

 

 

 

Click on this button to start the file scanning process. 

 

 

Click on this button to stop the current process. 

 

Click on this button to view the help manual. 

 

 

 

  



Open Entourage Database File 

The Microsoft Entourage database file should be opened in Stellar Phoenix Entourage Repair software to 

repair it. To select a database file, follow these steps. 

 

 Start the 'Stellar Phoenix Entourage Repair' software application. 'Select Entourage Database 

File' dialog box is displayed by default. Default location of database file is selected by default in 

the file path text box. 

          Or, 

Alternatively, click on 'Open' button on the toolbar or click on 'Open File' option from the File menu 

to select the file  to be repaired.  

 

 

 

 Click 'Browse' to select database file from a different location. 

 

 'Open File' dialog box is displayed. Select the entourage database file that is to be repaired. Click 

'Open' button. 

 



 

 

 The selected file path is displayed in the 'Select Entourage Database File' dialog box. Click on the 

'Start' button to start scanning process. 

 

 



 

  A dialog box is displayed showing the progress of the scanning process. You can click 'Stop' 

button in the dialog box to stop the file scanning process.  

 

  

 

 A summary message box is displayed, showing the recovery details after file scan is completed. 

Click 'Close' button to close the summary message box. 

 



 

  



 

Preview Mail 

Before saving the MS Entourage database file, the repaired file data can be previewed in the Stellar 
Phoenix Entourage Repair software. The data that can be previewed are e-mail folder and content, 
address book, calendar, tasks and notes. To preview the recovered mail, follow these steps.  

 Open the Entourage Database file in Stellar Phoenix Entourage Repair.  

 

 By default, the repaired mails are displayed in the preview window. Alternatively, to preview the 

mails, click on the 'Mail' button on the tool bar. 

 The preview window has three pane windows. The left-pane of the preview window shows all the 

folders in the mail box. The centre-pane shows the items in the selected folder. The right-pane in 

the preview window shows the content of the mail selected in the centre-pane. Click on the 'Inbox' 

folder in the left pane, then click on the desired mail in the centre-pane. The mail message is 

displayed in the right-pane of the preview window. 

 

 

 

 



 To preview the junk mails, click on the 'Junk E-Mail' folder in the left pane, then click on the 

desired mail in the centre-pane. The mail message is displayed in the right-pane of the preview 

window. 

 

 

 

 To preview the sent mails, click on the 'Sent Items' folder in the left pane, then click on the 

desired mail in the centre-pane. The mail message is displayed in the right-pane of the preview 

window.  

 



 

 

 

 To preview the deleted mails, click on the 'Deleted Items' folder in the left pane, then click on the 

desired mail in the centre-pane. The mail message is displayed in the right-pane of the preview 

window. 

 



 

 

 To preview the draft mails, click on the 'Drafts' folder in the left pane, then click on the desired 

mail in the centre-pane. The mail message is displayed in the right-pane of the preview window.  

 

 



 

Note: Preview of images is supported only with Mac OS X 10.7 and above. 

  



Preview Address Book, Calendar, Notes, Tasks 

MS Entourage also saves and manages personal information like address book, calendar, tasks 
and notes. All information is saved in same database file along with the mails. To preview the 
information in the repaired file, follow these steps. 

 To preview the 'Address Book', 
 

o Click on the 'Address Book' button on the tool bar.  
 

 

 

o The left-pane of the preview window shows the 'Address Book' folder. Centre-pane 

shows list of the 'Names'. Click on the desired 'Name' to view its detail in the right-pane.  

 

 To preview the 'Calendar',  

 

o Click on the 'Calendar' button on the tool bar. 

 



 

 

o The left-pane of the preview window shows the calendar folder. Centre-pane shows list of 

events. Click on the desired event to view its detail in the right-pane.  

 

 To preview the 'Notes', 

 

o Click on the 'Notes' button on the tool bar. 

 



 

 

o The left-pane of the preview window shows the 'Notes' folder. Centre-pane shows list of 

the 'Notes'. Click on the desired 'Note' to view its detail in the right-pane.  

 

 To preview the 'Tasks', 

 

o Click on the 'Tasks' button on the tool bar. 

 



 

 

o The left-pane of the preview window shows the 'Tasks' folder. Centre-pane shows list of 

the 'Tasks'. Click on the desired 'Task' to view its detail in the right-pane. 

  



Save the Repaired File 

The file shown as preview in 'Stellar Phoenix Entourage Repair' must be saved to import it in the 

Microsoft Entourage. To save the repaired file, follow these steps. 

 

 In the main window of the 'Stellar Phoenix Entourage Repair', click on 'Open' button on the tool 

bar to open the desired file.  

Or, alternatively, you can also click on 'Open File' option in the File Menu to select the file to be 

repaired.   

 Click on 'Save' button on the tool bar to save the repaired files. A 'destination folder' dialog box is 

displayed. 

Or, alternatively, you can also click on 'Save Repaired File' option in the File Menu to perform the 

same task . 

 

 

 

 Select the destination path for saving the file. Click on the 'Choose' button to start the saving 

process. 

 



 

 

 A dialog box is displayed showing the progress of the scanning process. You can click 'Stop' 

button in the dialog box to stop the file save process.  

 

 



 

 The repaired file will be saved by the name 'Main Identity.rge'. A 'Mailbox Saved Successfully' 

dialog appears. 

 

 

 

 If a file by this name already exists at the selected destination. A message box is displayed to 

confirm replacement of the existing file. Click 'Yes' to replace the existing file. Saving Process 

dialog box is displayed. 

Or, click 'No' to select a different location to save the file.  

 



 

  



Import repaired file in MS Entourage 

Stellar Phoenix Entourage Repair save file with name ”Main Identity.rge” by default. To import this file in 

Microsoft Entourage, follow these steps. 

 

 Start 'MS Entourage'. 

 Click on 'Import' option from the File Menu. A dialog box will appear. 

 Select 'Entourage information from an archive or earlier version' option from "Begin Import" section 

and click 'Next'. 

 Select 'Entourage Archive (.rge)' option from "What would you like to import?" section and click 

'Next'. 

 Select the path where you have saved the repaired file i.e. ”Main Identity.rge” and click 'Import'. 

 Entourage will start importing your data, click 'Done' after import process is completed. 

 'Main Identity.rge' appears in left pane of MS Entourage. 

 Recovered items will be displayed under 'Main Identity.rge' folder. 

  



FAQs 

1. What is Stellar Phoenix Entourage Repair Tool? 

 

Stellar Phoenix Entourage Repair Tool is a recovery tool for Microsoft Entourage 2004/2008, 

used for recovering Mails, Address Book, Notes,  Tasks and Calendar from a corrupted 

Entourage Database File (not readable by Microsoft Entourage).  

 

2. Can I see the preview of my recovered mails, tasks, calendar, notes etc. in the demo 

version of the software?  

 

Yes, in demo version you can see the preview of all recovered items, but to save your recovered 

items you need to purchase the software. 

 

3. What is the process to install Stellar Phoenix Entourage Repair tool? 

 

Before beginning installation process, quit all other programs, including anti-virus program, as 

they might interfere with the installation process. Setup file comes as a compressed .dmg file 

(.dmg.zip).  

 

To start Stellar Phoenix Entourage Repair, follow these steps. 

 

 Unpack StellarPhoenixEntourageRepair.dmg.zip file. 

 After decompressing it, double click .dmg file. This will mount a virtual volume - 

StellarPhoenixEntourageRepair. 

 Double-click StellarPhoenixEntourageRepair volume to open Stellar Phoenix 

Entourage Repair window.  

 Drag Stellar Phoenix Entourage Repair file to Applications folder. 

 To launch the software, double click on Stellar Phoenix Entourage Repair file in 

Applications folder. 

 This displays License Agreement. If user accepts the License Agreement, then the 

software is launched; otherwise, it quits. 

 

4. What is the process to remove the Stellar Phoenix Entourage Repair Tool? 

 

To remove the software, just drag and drop the Stellar Phoenix Entourage Repair file from 

application folder to trash bin. 



 

5. I have MS Entourage 2004 and MS Entourage 2008, both installed on my system. How can I 

repair my database of MS Entourage 2004? 

 

If both MS Entourage 2004 and 2008 are installed then 'Stellar Phoenix Entourage Repair' will 

select database of 2008 as default. To repair database of 2004, you have to use the browse 

option to select it from its installed location. 

 

6. How much time Stellar Phoenix Entourage Repair will take to scan and repair the 

database. 

 

The scanning and saving time totally depends upon the corruption level and size of the file. If the 

process is running that means that the software is still working. 

 

7. After saving my recovered items, how can I use recovered file in MS Entourage? 

 

Stellar Phoenix Entourage Repair save file with name ”Main Identity.rge” by default. To import this 

file in Microsoft Entourage follow these steps: 

 

 Start 'MS Entourage'. 

 Click on 'Import' option from the File Menu. A dialog box will appear. 

 Select 'Entourage information from an archive or earlier version' option from "Begin 

Import" section and click 'Next'. 

 Select 'Entourage Archive (.rge)' option from "What would you like to import?" section 

and click 'Next'. 

 Select the path where you have saved the repaired file i.e. ”Main Identity.rge” and click 

'Import'. 

 Entourage will start importing your data, click 'Done' after import process is completed. 

 'Main Identity.rge' appears in left pane of MS Entourage. 

 Recovered items will be displayed under 'Main Identity.rge' folder. 

 

8. Can I work with two MS Entourage Database file simultaneously? 

 

No, only single Entourage database file can be accessed. Before working with another file, first 

save the already open file since opening a new database file will automatically close the 

previously opened database. 

 



9. Can I use MS Entourage while Stellar Phoenix Entourage Repair is running? 

 

If you are using MS Entourage Database from default location, it is recommend not to use MS 

Entourage. If you are choosing database from different location you can use MS Entourage. 

  



Legal Notices 

Copyright 

 

Stellar Phoenix Entourage Repair software, accompanied user guide and documentation are copyright 

of Stellar Information Technology Private Limited, with all rights reserved. Under the copyright laws, this 

user guide cannot be reproduced in any form without the prior written permission of Stellar Information 

Technology Private Limited. No Patent Liability is assumed, however, with respect to the use of the 

information contained herein. 

 

Copyright © Stellar Information Technology Private Limited. INDIA. 

 

Disclaimer 

 

The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 

REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 

INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS 

OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND 

THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, 

BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 

WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE 

THEREOF. 

 

Trademarks 

 

Stellar Phoenix Entourage Repair® is a registered trademark of Stellar Information Technology Private 

Limited. 

Mac OS X® is a registered trademark of Apple Computers. 

All Trademarks Acknowledged. 



All other brands and product names are trademarks or registered trademarks of their respective 

companies. 

 

License Agreement 

 

Stellar Phoenix Entourage Repair 

Copyright © Stellar Information Technology Private Limited. INDIA. 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar Phoenix Entourage Repair. 

 

Your Agreement to this License 

 

You should carefully read the following terms and conditions before using, installing or distributing this 

software, unless you have a different license agreement signed by Stellar Information Technology Private 

Limited. 

 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 

use any copy of Stellar Phoenix Entourage Repair with which this License is included, you may return the 

complete package unused without requesting an activation key within 30 days after purchase for a full 

refund of your payment. 

 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 

Stellar Phoenix Entourage Repair. For purposes of this License, if you have a valid single-user license, 

you have the right to use a single Licensed Copy of Stellar Phoenix Entourage Repair. If you or your 

organization has a valid multi-user license, then you or your organization has the right to use up to a 

number of Licensed Copies of Stellar Phoenix Entourage Repair equal to the number of copies indicated 

in the documents issued by Stellar when granting the license. 

 

Scope of License 

 

Each Licensed Copy of Stellar Phoenix Entourage Repair may either be used by a single person or used 

non-simultaneously by multiple people who use the software personally installed on a single workstation. 

This is not a concurrent use license. 

 

http://www.stellarinfo.com/


All rights of any kind in Stellar Phoenix Entourage Repair, which are not expressly granted in this license, 

are entirely and exclusively reserved to and by Stellar Information Technology Private Limited. You may 

not rent, lease, modify, translate, reverse engineer, decompile, disassemble or create derivative works 

based on Stellar Phoenix Entourage Repair nor permit anyone else to do so. You may not make access 

to Stellar Phoenix Entourage Repair available to others in connection with a service bureau, application 

service provider or similar business nor permit anyone else to do so. 

 

Warranty Disclaimers and Liability Limitations 

 

Stellar Phoenix Entourage Repair and all accompanying software, files, data and materials are distributed 

and provided AS IS and with no warranties of any kind, whether expressed or implied. You acknowledge 

that good data processing procedure dictates that any program including Stellar Phoenix Entourage 

Repair must be thoroughly tested with non-critical data before there is any reliance on it and you hereby 

assume the entire risk of all use of the copies of Stellar Phoenix Entourage Repair covered by this 

License. This disclaimer of warranty constitutes an essential part of this License. 

 

In addition, in no event does Stellar authorize you or anyone else to use Stellar Phoenix Entourage 

Repair in applications or systems where its failure to perform can reasonably be expected to result in a 

significant physical injury or in loss of life. Any such use is entirely at your own risk and you agree to hold 

Stellar harmless from any and all claims or losses relating to such unauthorized use. 

 

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special, 

incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss 

of business profits, business interruption, loss of business information, or any other pecuniary loss) 

arising out of the use of or inability to use the software product or the provision of or failure to provide 

support services, even if Stellar Information Technology Private Limited has been advised of the 

possibility of such damages. In any case, Stellar Information Technology Private Limited’s entire liability 

under any provision shall be limited to the amount actually paid by you for the software product. 

 

General 

 

This License is the complete statement of the agreement between the parties on the subject matter and 

merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive 

jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the 

State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries 

of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any 



violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or 

future violation of the same provision or any other provision of this License. 

 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

 

  



About Stellar 

Stellar Information Technology Private Limited is a trusted name in the field of Data Recovery and Data 

Protection Software for more than a decade. 

We provide the widest range of Data Recovery Products. Our range includes Data Recovery Software for 

almost all Operating Systems and File Systems. 

Product line: 

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

E-mail Recovery 

A wide range of e-mail recovery, e-mail repair and e-mail conversion applications for MS Outlook, MS 

Outlook Express and MS Exchange useful in instances of data loss due to damages and corruption of E-

mail. More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives, 

System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser 

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >> 

 

For more information about us, please visit www.stellarinfo.com 

 

http://www.stellarinfo.com/disk-recovery.htm
http://www.stellarinfo.com/database-recovery.php
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/prevent-dataloss.htm
http://www.stellarinfo.com/windows-tools/file-eraser-mac.php
http://www.stellarinfo.com/

